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/8 Before Attending

 Make sure you have a Java JRE
— At least 5 (aka 1.5)
— IBM or Sun’s (not GCJ included with Linux)

* Download Eclipse Classic for your platform

— eclipse.org/downloads

* Save the archive file, you’ll need it again in the tutorial

— Current release “Galileo” is Eclipse 3.5

How to Write Your Own Eclipse Plug-ins :
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e Java

* Linux: make sure you have Sun or IBM Java:

Java HotSpot == Sun
9 Applications Places System Q li_D

beth@localhost:~

=
File Edit View Terminal Tabs Help

[beth@localhost ~]$ java -version

java version "1.6.0 10"
Java(TM) SE Runtime Environment (build 1.6.0 10-b33)

Java HotSpot(TM) Client VM (build 11.0-bl5, mixed mode, sharing)
[beth@localhost ~]$ g

* EitherJaval.50r1.6isok (Notgcjl)
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Eclipse overview and Installation

Installing extensions (“Plug-ins”) via Update Manager

New Plug-in Project Wizard, create an Action button

—  Plug-in component tour: Manifest, code, resources, etc.

— Launching (“self-hosting”) — testing your plug-in

More extensions: adding a view ... modify code ... run debugger
Writing Help for your plug-in; including HTML and XML editing
Packaging your plug-in(s): Eclipse features; Update Sites & testing
Handmade extension: Word Counter in editor toolbar -- If time permits

Source code analysis: C/C++ example — and eclipse.org source code
repository exploring -- If time permits
Summary, References, Where to go from here
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Eclipse: Overview

* Open Source IDE & Development Platform
— Platform-independent
- Or|g|na”y dOnatEd by IBIVI in 2001, Foundation est. in 2004

— Now over 180 vendor members (more than IBM)
» 15 Strategic members — sit on Eclipse Foundation Board

* http://www.eclipse.org/membership/showMembersWithTag.php?TaglD=strategic

— Now over 33 ECIipse prOjectS in simultaneous release
* Over 100 projects overall; more from independents

— IDE (develop with Eclipse)

 And Pla tfor M (develop and deliver your Application on top of Eclipse)

How to Write Your Own Eclipse Plug-ins :
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Eclipse SDK

Status

RCRNRKKKKKKLKKLKELEKKKKK
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Platform
Windows (Supported Versions)

Windows (x86_64) (Supported Versions)

Windows (x86/WPF) **early access®* (Supported Versions)
Linux (x86/GTK 2) (Supported Versions)

Linux (x86/Motif) **testing only**

Linux (x86_64/GTK 2) (Supported Versions)

Linux (PPC/GTK 2) (Supported Versions)

Linux (S390/GTK 2) **early access™* (Supported Versions)
Linux (S330x/GTK 2) **early access** (Supported Versions)
Solaris 10 (SPARC/GTK 2)

Solaris 10 (x86/GTK 2)

HP-UX (IA64_32/Maotif)

AIX (PPC/Motif)

Mac OSX (Mac/Cocoa) (Supported Versions)

Mac OSX (Mac/Cocoa/x86_64) (Supported Versions)

Mac OSX (Mac/Carbon) (Supported Versions)

Source Build (Source in .zip) (instructions)

Source Build (Source fetched via CVS) (instructions)

How to Write Your Own Eclipse Plug-ins :
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e Releases

2006: 3.2 Callisto
2007: 3.3 Europa
2008: 3.4 Ganymede
2009: 3.5 Galileo 4=
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pse Packages
http://eclipse.org/downloads

Eclipse Downloads Compare Packages

Check out this table to find out what is included in each package.

0O v 9 &
JEE — BIRT
Java Java EE CI/C++ RCP/Plugin  Modeling Reporting

v
v

Eclipse Packages Projects

Galileo Packages (based on Eclipse 3.5

Eclipse IDE for Java EE Developers (187 MB)

Tools for Java developers creating Java EE and Web applications, including a Java IDE, tools

for Java EE, JPA, JSF, Mylyn and others. More... RCP/Platform
JEE | Downloads: 14,912

Cvs

Eclipse IDE for Java Developers (91 MB) EMF
The essential tools for any Java developer, including a Java IDE, a CVS client, XML Editor and

Mylyn. More... GEF
Downloads: 5,240

JDT
Eclipse IDE for C/C++ Developers (78 MB)

é “‘; An IDE for C/C++ developers with Mylyn integration. More... Mylyn

Downloads: 2,844

ubc

b b YR NS R N B N R
S ] e e
ANANANANANANEN

Eclipse for PHP Developers (137 MB) Web Tools
Tools for PHP developers creating Web applications, including PHP Development Tools (PDT),
Web Tools Platform, Mylyn and others. More... Java EE

ANEEANENAN

b e VR N B NS B S R N N B RN RN S R N RS
b e

N [NSPSSN] SN SPS S SS SN S

Downloads: 2,668 Tools
XML Tools v v v
Ecllpse for RCP/Plug-in Developers (182 MB)
5 set of tools for pers who want to create Eclipse plug-ins or Rich Client RSE

-QI) = Applications. Itincludes a SDK, per tools and source code, plus Mylyn, an XML
editor and the Eclipse Communication Framework. More...
Downloads: 1,386 EclipseLink
Ecllpse Modeling Tools (includes Incubating components) (362 MB) PDE \/ ‘/ /

contains a ion of Eclipse Modeling Project components, including
‘ EMF GMF, MDT XSD/OCL/UML2, M2M, M2T, and EMFT elements. It mcludes a complete SDK, Datatools
developer tools and source code. Note that the Modeling
components, as indicated by feature numbers less than 1.0.0 on the feature ||s! More
Downloads: 923 coT v
Eclipse IDE for Java and Report Developers (218 MB) BIRT
JEE JEE tools and BIRT reporting tool for Java developers to create JEE and Web applications that
b= s also have reporting needs. More... ECF \/
BIRT  Downloads: 898
GMF v

Pulsar for Mobile Java Developers (112 MB)
Pulsar is a tools platform for Mobile Java Developers. Itincludes the Eclipse Platform, Java PDT /
Development Tools (JDT), Mobile Tools for Java (MTJ), Mylyn and Plugin Development

@ Environment (PDE). Pulsar also makes it easy to download SDK from different handset
manufacturers. More... MDT \/

Eclipse Classic 3.5.0 (161 MB)
The classic Eclipse download: the Eclipse Platform, Java Developm
Development Environment, including source and both user and progra
Please look also at the Eclipse Project download page. More...
Release notes | Other downloads | Documentation
Downloads: 5,244

MTJ v
Tools, and Plug-in

er documentation. Legend:

‘/ Included (with Source) ‘/Included Partially Included

How to Write Your Own Eclipse Plug-ins :
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<3 Parallel Tools Platform

My committer status involvement with Eclipse:
* Eclipse.org/ptp

* Tools for High Performance Computing

* |BM funding from DARPA

* Develop, Analyze, Run, Monitor, Debug, Tune,
Repeat

How to Write Your Own Eclipse Plug-ins :
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4@5)5 = Eclipse and PTP: Parallel Tools Platform
http://eclipse.org/ptp

» Bring richness of commercial development tools to the parallel programmer

= Open and extensible platform to encourage further development

Productivity of .
De
COding & m Y |d
Analysis Building
oo Launching
Monitoring
CDT: C/C++ .

Photran: Fortran

‘‘‘‘‘
SN E R

a0e
,,,,,,,,,,,
Jobs View \‘;
Current /
Remote :
H (0] St Process [ Bresl;s;ints

View

Sol
\ / Viirvcve BN

Performance Tuﬁing Parallel Debugging
External Tools Framework (ETFw) o




%r | EC“pSQ Installation

* Download from eclipse.org/downloads
— You need a Java JRE (at least JRE 5)
* Not GCJ distributed with Linux! Get Sun or IBM.
— This tutorial is based on Eclipse 3.5 (“Galileo”)

— Many distributions — we’ll use “Eclipse Classic”

— Other distros target different dev. Audiences
o C/C++, Web, Java, Java EE, etc.

— Download and unzip/untar
* That’s it!
* Executable: eclipse or eclipse.exe

How to Write Your Own Eclipse Plug-ins :
OSCON 09
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“adpos- Hints and tips:
Multiple installations

You can easily have multiple installations of eclipse.
Eclipse extracts into a single dir: ‘eclipse’

Put that wherever you want

» /Users/beth/ecl/eclipse-3.5/eclipse

» /Users/beth/ecl/eclipse-3.4/eclipse

» /Users/beth/ecl/eclipse-3.3/eclipse

* Right now | have (how many?) on my machine
— What can I say, I'm a pack rat ©

How to Write Your Own Eclipse Plug-ins :
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Hints and tips: eclipse.ini

Before Launching

Hints and Tips

— Edit the eclipse.ini file to set defaults.
Suggestions:

* Change heap size from
-Xms256m to -Xmx512m

» Set -showlocation to show
workspace name in title bar
— Don’t split another arg/value pair!

Eclipse.ini location

— Mac: eclipse/Eclipse.app/Contents/
MacOS/eclipse.ini

— Win/Linux: eclipse/eclipse.ini

® 00 _ Emacs@Macintosh-beth.local !
DEExHBES RS XD
-startup

../../../plugins/org.eclipse.equinox. launcher_1.0.200.v20090520. jar

--launcher.library

../../../plugins/org.eclipse.equinox. launcher.carbon.macosx_1.0.200.v202
€ 090520-1835

-showsplash

org.eclince . platform

=showlocation
= i xPermSize

256m
-vmargs

iiﬁ ﬂ E. ./Resources/Eclipse.icns

-XstartOnFirstThread
-Dorg.eclipse.swt.internal.carbon.smallFonts

--:** eclipse.ini  All L15  (Conf[Space])

Dired (directory): /Applications/ecl/eclipse-3.5RC3/eclipse/Eclipse.appi
s /Contents/Mac0S/]

How to Write Your Own Eclipse Plug-ins :
OSCON 09
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Hints and tips: eclipse.ini

. Linux
Windows

beth@localhost:~/ecl/eclipse-3.5/eclipse

-/[o)Ed| | Hle Edit View Terminal Tabs Help
File Edit Options Buffers Tools Help
gstartup

o] eclipse.ini - Epsilon
File Edit Search Process Utlity Window Help

D E & & Bi |~ a? X .
| | |—I | | I | | Q| | | | plugins/org.eclipse.equinox.launcher 1.0.200.v20090520.jar

-starcup ) ) . ~ ~ o --launcher.library

pligtnaorg ectipac. cquinot.Asuacher 1-0-200-v20030520-Jax plugins/org.eclipse.equinox.launcher.gtk.linux.x86 1.0.200.v20090520

—--launcher.library
plugins/org.eclipse.equinox.launcher.win32.win32. x86_1.0.200.v20090519

-showsplash

iy

THXMaxPermSize

—showlocati
256m
-vmargs

— \ecl\eclipse-3.5RC3\eclipse\eclipse.ini [Ini Unix]&11 = Line: 7 Co
Now 70 x 16
-uu-:---F1 eclipse.ini All L1 (Conf[Space])
Loading conf-mode...done
How to Write Your Own Eclipse Plug-ins : 13
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C! 28 Launch Eclipse

Jeclipse or double-click executable

— Warning: to assure environment is translated to
the executable, you may want to run from
command line (e.g. Mac OS X)

* Or edit: environment.plist

— Whatever your environment, make sure Java is in
your path

How to Write Your Own Eclipse Plug-ins :
OSCON 09
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Launch Eclipse

* Launch eclipse; default workspace probably OK

800 Workspace Launcher | 800 Workspace Launcher

Select a workspace

Select a workspace
Eclipse SDK stores your projects in a folder called a workspace. Eclipse SDK stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session. Choose a workspace folder to use for this session.

fUsers/beth/Documents/workspace i-‘ Workspace: | /Users/beth/ews/tutorial-workspace ;—‘
| usually change it

[ Use this as the default and do not ask again

Workspace:

[ Use this as the default and do not ask again

( Cancel ) ( OK ) ( Cancel ) ( OK )

AEH=2

* Welcome page appears; go to workbench

Weicome l‘a Eclipse

*Close Welcome tab

or
«Select “Go to workbench” icon

How to Write Your Own Eclipse Plug-ins :
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Eclipse Workbench

< Java - Eclipse SDK == PerS peCtIVGS

File Edit Source Refactor Navigate Search Project Run Window Help

L~ -0 Q- BHEG-®- Y | & Java
[£ Package Explor 52 ?3 Hierarchy | = O = B[ 5= outiine £2 =0
= v An outline is not available. =
= S Hnet Ve e 00 Java - Eclipse SDK h
[ witd |0 Q- | E#H G| @5 5 & Java
[ Ppackage Expl 3 ] Hierarchy] =g = B[ 3= outline P NG = 0|
= <& v An outline is not available.
=

|2( Problems &2 @ Javadoc | &, Dedaration

Project/ Editor View
Package

—= 0 items

EXpIO rer |2 Problems 2\ @ Jnvndoc\| [ Declarntion\| SI=H)
5 [ A

V i eW | Description d _ - Resource
Stacked views

I ]

IEEEREES
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* Install other eclipse
tools

* Help > Install New
Software..

* No need to do
anything now.

How to Write Your Own Ec
OSCON 09

Installing extensions

19.0.0 Install

Available Software

Check the items that you wish to install. ) —
-
=

_]’ Add... )

ttp:/ /download.eclipse.org/releases/galileo

Find more software by working with the 'Available Software Sites' preferences.

Name Version
U EclipseRT Target Platform Components A

U Mobile and Device Development

U Modeling

U Programming Languages

U SOA Development

U Test and Performance

U Tools and Goodies !

U Web, XML, and Java EE Development !
«J*= Apache MyFaces Trinidad Tag Suppor 2.2.0.v20090517-20-7w311A1636 |
“J= Axis2 Tools 1.1.0.v200905242110-78-FBpDZRDEGFdPdI !
«J* Dali Java Persistence Tools 2.2.0.v200905310000-7L708gFBBoPROQLj#
<) Dali Java Persistence Tools - EclipseLi 2.2.0.+200905310000-658ZAkF77g7RIB777 !

O «J* Eclipse Faceted Project Framework  3.1.0.+200906020515-377-8s733L3D7739 w/

<J* Eclipse Faceted Project Framework JD" 3.1.0.v200905220328-377-85733L3D794C

dvvvyVvVvyVyYVYyYVYyy

<= Eclipse Java EE Developer Tools
M «J* Eclipse Web Developer Tools
M <)== Eclipse XML Editors and Tools
M <)== Eclipse XSL Developer Tools

Details

3.1.0.v200905242144-7_7EGr_FQRWRZSME
3.1.0.v200905242131-7R77FShEVW2xUGpF
3.1.0.v200905240756-7H6FMVDxtkM-50g}
1.0.0.v200905242203-7R7T7IFIhlehWfz064 v

M Show only the latest versions of available software || Hide items that are already installed
M Group items by category What is already installed?

M Contact all update sites during install to find required software

1"?‘: < E ( Next > \ Cancel

Iipée Plug-ins :
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* Linux
Update Mgr

e Manual
Installation:

* dropins/ folder

7/13/09

Installing extensions

= Install k3
Available Software

Check the items that you wish to install. "
Work with: | Galileo - http://download.eclipse.org/releases/galileo v Add...

Find more software by working with the 'Available Software Sites' preferences.

Name Version
4 Uoi Test and Performance
< [= 100 Web, XML, and Java EE Development
4+ Apache MyFaces Trinidad Tag Support (Optic 2.2.0.v20090517-20-7w311A1636
4+ Axis2 Tools 1.1.0.v200905242110-78-FBpDZRDEGFdPdLYYe
4= Dali Java Persistence Tools 2.2.0.v200905310000-7L70AFFBBoPRIQNdMUL_f
4+ Dali Java Persistence Tools - EclipseLink Sup 2.2.0.v200905310000-65A7AkF77g7SGH7997
4* Eclipse Faceted Project Framework 3.1.0.v200906080522-377-85733L3F3)3DAB
4+ Eclipse Faceted Project Framework JDT Eng 3.1.0.v200905220328-377-85733L3F3/3D33
4+ Eclipse Java EE Developer Tools 3.1.0.v200905242144-7_7EGr_FQRwWRZSMEO08aqRiT1Skap
< i Eclipse XML Editors and Tools 3.1.0.v200905240756-7H6FMVDxtkM-50gPGKK4xQocS5AL

4k Eelinse XS1 Develoner Tonls 1.0.0v200905242203-7R7T7IFIhlehWfz0A4nz0YX1 b
Details

Eclipse Web Developer Tools, including HTML, CSS, XHTML, etc.

More...

<! Show only the latest versions of available software Hide items that are already installed

< Group items by category What is already installed?

v Contact all update sites during install to find required software

)

How to Write Your Own Eclipse Plug-ins :
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<9 What is a plug-in?

An Eclipse plug-in is a unit of eclipse function
It “extends” the eclipse workbench.

Has a special type of manifest and (usually) a
plugin.xml file

May depend on other plug-ins
Can (usually does) contribute to other plug-ins
Lots of plug-ins already exist (LOTS)

—  http://www.eclipseplugincentral.com/

— http://eclipse-plugins.info and on http://eclipse.org

How to Write Your Own Eclipse Plug-ins :
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<9 Eclipse examples

 We will develop Eclipse plug-ins in this tutorial
via the built-in example wizards

* How much can you learn from “hello world” ?

— A lot, actually

— Basic plug-in structure, how to hook in, where to
put your code, what your code can do

— Then we’ll go from there.

How to Write Your Own Eclipse Plug-ins :
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e New Plug-in project

* File > New > Project...

* Under Plug-in Development
— Select Plug-in Project; Next >

6-’:.0_- - - 'NewPr(')ject'

Select a wizard %

Create a Plug-in Project

Wizards: /
type filter text /

» =" JavaScript ) §
¥ = Plug-in Development

3 Feature Patch

LJ¥ Feature Project

: Fragment Project E
~# Plug-in from Existing JAR Archives

;¥ Plug-in Project

&~ Update Site Project -

) < Back < ( Next > ) i Cancel \ Finish

Hints and tips:
Make the project name the base package
name - Helps with linking up IDs
(can be difficult to get right later)

Give it a name, e.g.
« com.myco.helloplugin
Next >

8.0 O New Plug-in Project

Plug-in Project

Create a new plug-in project

Project name{ | com.myco.helloplugir|

™ Use default location
Location: rs/beth/ews/tut0707/com.myco.h gin

Project Settings

M Create a Java project

Source folder: src

Output folder: bin

Target Platform
This plug-in is targeted to run with:

@ Eclipse version: (35 )

() an 0OSGi framework: |

Working sets
[] Add project to working sets

Working sets:

':;7\ (" <Back m Cancel )

-

How to Write Your Own Eclipse Plug-ins :
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New Plug-in project (2)
* Content page 800 e

Content J—
([ Defa u Its a re O K Enter the data required to generate the plug-in. @_‘
° N eXt > Properties

ID: com.myco.helloplugin

Version: 1.0.0.qualifier

Name: Helloplugin

Provider: MYCO

Execution Environment: ’ J2SE-1.5 ﬂ ( Environments... \
Options

M Generate an activator, a Java class that controls the plug-in's life cycle

Activator: com.myco.helloplugin.Activator
M This plug-in will make contributions to the Ul

"] Enable APl Analysis

Rich Client Application

Would you like to create a rich client application? (OYes @ No

Cancel \ ( Finish )

How to Write Your Own Eclipse Plug-ins :
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Plug-in templates

* Choose “Hello, World Command” Template

————— T e W -

18,00 New Plug-in Project

Templates

plug-in.

Select one of the available templates to generate a fully-functioning i

Available Templates:

" Custom plug-in wizard

Hello, World Command
* Plug-in with a multi-pa
“* Plug- a popup menu

<% Plug-in with a property page

@ Plug-in with a view

<% Plug-in with an editor

<% Plug-in with an incremental project
<% Plug-in with sample help content

[21 Create a plug-in using one of the templates

This wizard creates standard plug-in
directory structure and adds the
following:

® Command contribution. This
template creates a simple command
contribution that adds Sample Menu
to the menu bar and a button to the
tool bar. Both the menu item in the
new menu and the button invoke the
same Sample Action. Its role is to
open a simple message dialog with a
message of your choice.

Extensions Used
® org.eclipse.ui.commands
® org.eclipse.ui.handlers
® org.eclipse.ui.bindings

® org.eclipse.ui.menus

. ® T O  New Hello World Command nlyg-in project
Forward F

Sample Command Contribution ,_.J‘\ 4
h=

This template will generate a sample command contributionwith a
menu, a menu item and a tool bar button.

Java Package Name: com.myco.helloplugin.handlers

Handler Class Name: SampleHandler

Message Box Text: Hello, Eclipse world

.

|j/’_):‘: < Back y) (e Nexi:' y (" cancel /\ ( Finish )

7/13/09

(?) ( <Back Next >

| )
e/ \

(_ Cancel \ ( Finish )

Hit Finish (or Next > then Finish)

How to Write Your Own Eclipse Plug-ins :
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Switch Perspectives

* Accept switch to Plug-in Development Perspective

—

Open Associated Perspective?

1 This kind of project is associated with the Plug-in Development perspective.

This perspective is designed to support efficient development and integration of

plug-in projects. It adds the Plug-ins and Error Log views which are particularly
useful.

Do you want to open this perspective now?

"] Remember my decision

/_ No \ Yes )

If you were already in the Plug-in Development Perspective,
you won’t see this dialog.

How to Write Your Own Eclipse Plug-ins :
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Perspectives

. . . . m Help . - _
Perspectives provide combinations of ™ \a, window

. ] ] | New Editor
views and editors that are suitedto .

Open Perspective > %> Debug
>

Show View &' Java
[75 Resource

Performing a particular set of tasks.

Customize Perspective...

. . . Save Perspective As...
Hlnts and Ups Reset Perspective... m
) . Close Perspective
You can easily switch Close Al Perspectives
. . Navigation [ 2
between perspectives via:
Shortcut bar
1. Window > Open Perspective, or =
Eé {2z CVS Reposit... %’;Debug <J=Plug-in Deve... g}’java
2. Click the “Open Perspective” button ‘1— ;ﬁ JDebug
< ava
on the shortcut bar, B  or -, Resource

3. Click one of the perspective icons Other...
in the shortcut bar

You may need to drag the shortcut bar’s left edge to make it wider, in order
to show all the perspective icons that have been active.

How to Write Your Own Eclipse Plug-ins :
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Simple Plug-in created

* Edit the plug-in
manifest:
MANIFEST.MF

™ O O  Plug-in Development - com.myco.helloplugin/META-INF/MANIFEST.MF - Eclipse SDK - /Users/beth/ews (tutorial-workspace (@)
J J sy QO Q- J J @ J - - v - J [ «J=Plug-in Deve... &>
[£ Package Ex 3 Plug- ins I+ com.myco.helloplugin 3 = B|(8= outline 2 =8
%
G . T & a |
2 V|| & overview A = |3
v b com.myco.helloplugin Overview
> E), JRE System Library [J2SE-1.5 General Information Plug-in Content v Dependencies
A
» =i Plug-in Dependencies This section describes general information about this o :"1 org.eclipse.ui
> (#src plug-in. Thicontenl of the plug-in if %= org.eclipse.core.run
» G icons £ Dependencies: lists all Runtime
D com.myco.hellopluginl plug-in's classpath to d
¥ [~ META-INF . J v Extensions

/ Runtime: lists the librar

; )+ MANIFEST.MF
D build.properties
i plugin.xml

Version 1.0.0.qualifier in's runtime. 4= org.eclipse.ui.comm
= org.eclipse.ui.handle

basics
plugin.xml
extensions
e See XML of manifest

* OSGivs plug-in
extensions

Hints and Tips:

To link current editor with location in project.

7/13/09

Name Helloplugin Extension / Extension Poin #= org.eclipse.ui.bindin
“= org.eclipse.ui.menus;
This plug-in may define exte i i
Provider MYCO ¥ " Extension Points
:] Extensions: declares cc Build

makes to the platform.
form
Platform Filter ! Extension Points: decla

plug-in adds to the plat

Activator: com.myco.helloplugin.Ac Browse...

. N . . . Testing

EAC(IVE(& this plug-in when one of its classes is loaded

MThis plug-in is a singleton Test.rhis' plug-in by launchir_

- application: v
<€ =) ) >
Overview| Dependenmes| Runt:me‘ Extensions ‘ Extension Points | Bulld‘ MANIFEST.MF T >
Q] Error Log 2 \«7 Tasks | Rl Problems | 8| x X @ v =0
Workspace Log

type filter text

Message Plug-in

¥ & A handler conflict occurred. This may disable some ¢ org.eclipse.ui.workbench  6/8/09 2:17 PM

& Conflict for 'org.eclipse.wst.sse.ui.format':Handli org.eclipse.ui.workbench ' 6/8/09 2:17 PM
<€ D ' » || v 9 unable to load the reositorv htto:/ /download.eclios ora.eclinse.eauinox.o2.ui | 6/8/09 1:56 PM

Iee J

&

Link with editor

&, Plug-in Dependencies
> (#src
P (= icons

-
v (= META-INF

How to Write Your Own Eclipse Plug-ins i manirest.vr
OSCON 09 b build.properties
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e Activator controls
plug-in life cycle

Java code for
“Hello world”

Plug-in source code

(% package Ex 53 e Plug-ins| = O

-

=

v ;,:J com.myco.helloplugin
P =, JRE System Library
P =i Plug-in Dependencies
v (@ src
v 3} com.myco.helloplugin
P |J] Activator java
v £ com.myco.helloplugin.hanc
» |J] SampleHandler java
P (= icons
¥ (= META-INF
4+ MANIFEST.MF
loré build.properties

L nluain xml

‘Ju SampleHandler java I s com.myco.helloplugin

public SampleHandler() 1

}

/%%

* the command has been executed, so extract e

* from the application context
V"
public Object execute(ExecutionEvent event) th
IWorkbenchWindow window = HandlerUtil.gets
MessageDialog. openInformation(
window.getShell(),
"Helloplugin",
"Hello, Eclipse world");
return null;

action

* Double-click file to open in editor

Enough of a tour. Let’s run with our new
extension!

How to Write Your Own Eclipse Plug-ins :
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D Running/Testing plug-ins

e “Self-hosting”- launch another instance of Eclipse

* Runtime workbench launches with (usually) everything in the
development workbench, plus the new plug-ins being developed

.......

Launch
= Configuration

> update3

<€ >

Your plug-in code is here
In your workspace

e 00 Java - Eclipse SDK
v Q- Q| EHFEC Eajjava [
@ 5 v 55| v v Sy
\
[2 Pa_ 52 < Hi | = O = B | 5= outline 8 =0j|
= An outline is not available.
Runtime
\
}
workbench '
|2 Problems 53 @ Javadoc| [iZ, Declaration v =08
0 items
Description A |Resource
<

Your “user’s” workspace

28
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I
 Run > Run Configurations... 1
* New Eclipse Application

YeYe

Run Configurations

Create, manage, and run c¢nfigurations

Create a configuration to lauich an Eclipse application.

r
EIEERN |

r text

© Eclipse Application
© New_configuration

51 Java Application
Ju Junit

JU JUnit Plug-in Test
4 0sGi Framework

7/13/09

Name: New_configuration

=] Main

Workspace Data

()= Arguments\l & Plug—ins\l 6= Configuration] = Tracingl !

Location:  ${workspace_loc}/../runtime-New_configuration

[ Clear: (®)w

e og only
V! Ask for confirmation before clea ing
Program to Run

® Run a product: org.eclipse.sdk.ide

O Run an application:  org.eclipse.ui.ide.workbench

Run

® O O Plug-in Development - com.myco.helloplugi

(wis

v IEJ com.myco.hellg
P> =i, JRE System
» =, Plug-in Dependencies ”

-

Or use Run icon menu

|3 Qv Q- | & G- | @ 4~

[ package Ex S@X %

Run As
Run Configurations
Organize Favorites...

On Plug-ins tab

Default selection is what we want:
Launch with all ... plugins

YeYe

Run Con

J

landler
p ublic

* the
* fro

urations

Create, manage, and run configurations

Create a configuration to launch an Eclipse application.

G

wt
5

type filter text

v & Eclipse Application
© New_configuration
=5 Java Applet
] Java Application
Ju Junit
JU Junit Plug-in Test
4 0SGi Framework

How to Write Your Own Eclipse Plug-ins :
OSCON 09

Name: New_configuration
/D Main (9= Argumen! ° Plug-ins nfigurntion“ = Trncing\ ]
Launch with: | all workspace and enabled target plug-ins B D
type filter text
Plug-ins

Close

Run! (

4\ ( Run )
N
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D

Running your new plug-in

* Another instance of Eclipse is launched

e Go to workbench

Execute:

e Toolbar icon
or
Menu

® Eclipse File Edit Source Refactor Navigate Search Project Rupf™

s ]
(]8> |30 Q- | EH G |® 5] | ®
|ft$ Package Expl Ezvx Hierarchy | = El”
|
! .00 Helloplugin

1 Hello, Eclipse world

How to Write Your Own Eclipse Plug-ins :
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s Basic plug-in tour

* Manifest
— MANIFEST.MF and.plugin.xml

o Java COd e ' Package Explorer 3 < Plug-ins == =1l

I L.._—':!com.example.hellov.vorld
v L,.—_%:'com.myco.helloplugin

— » =\ JRE System Library
U S u a I |y u n d e r /S rC » =, Plug-in Depe'ndencies
» B src
b = .settings

e Other resources

» (= META-INF
X .classpath
X .project

— Many are optional i roperies

<% plugin.xml

— lcons, html files, etc.

How to Write Your Own Eclipse Plug-ins :
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You’'re done!

You have now written your first Eclipse
plug-in!

You’'re done!
... Just kidding!
Close the runtime workbench

How to Write Your Own Eclipse Plug-ins :
OSCON 09

32



<9 Next project

* Let’s make another plug-in that creates an
eclipse view
* This will use more of the

— Eclipse extension points (how eclipse calls your
code) and

— APIs (the java code you write that does eclipse
stuff in your plug-in)

— And we’ll modify the java code

How to Write Your Own Eclipse Plug-ins :
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D

New project

* New Project, Plug-in projegjco

New Plug-in Project

Templates p
. N a ' I I e * Select one of the available templates to generate a fully-functioning plug-in. /
[]

M Create a plug-in using one of the templates

com.myco.viewplugin

¥ Custom plug-in wizard This wizard creates standard plug-in directory
Hello, World structure and adds the following:

— Project name = package root | Sy o * Sample viw. i emple e
— s i Iti- : workbench view. The view is contributed to
. Plug !n w!th a multi-page editor the workbench by creating a category. The
7 Plug-in with a popup menu view can be opened by selecting Window,

. . . . 4
— ¥ Plug-in with a property page Show View and then Other... on the menu
- plug'ln Id. Ge mn g th IS S@t U7 Plug-in with a view bar. The template demonstrates

& implementation of pop-up menu support,
local tool bar, double-click, sorting and

up at project start will save [/ | Grimmimame ™ | St wm.

you headaches later. i —
* Next, Next
)

¢ Choose ”PIUg_in With a VieW’ @) ( <Back ) ( Next> ) ( cancel ) € Finish )

% Plug-in with an editor

* Next, Finish

How to Write Your Own Eclipse Plug-ins :
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& Run

* Run with just the new plugin

 Run > Run Configurations
— New Eclipse application
— Plugins tag: Launch with: plugins selected...only

— Under Workspace, select the viewplugin
(See next slide)

How to Write Your Own Eclipse Plug-ins :
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Run with just the
new plugin

*Run >

RU n CO nfig U rations {| ¥4 Eclipse Application ’ type filter text \ ) e

*Plugins tab:

eLaunch with: plugins

selected...only

*Under Workspace,
select the viewplugin

Run configuration for launching
only the view plug-in

OO0 Run Configurations

Create, manage, and run configurations

Create a configuration to launch an Eclipse application.

>

-»l,.
: - 3o
| X = Name: ' my view plugin H

er text
— =] Mai
¢ |C/C++ Application
[€]c/C++ Remote Applicati Launch with: T
4 DSF PDA Application

5) Configuration | £ Tracing | Fi§ Environment| =] Common | 1

'<I= Plug-ins

PIug-ins selected below only K ? Default Start level: 4

- ] — Select All )
. . . § & my view plugin Plug-ins '
*New Eclipse application | s '\ 8 v oworkspace A useaAl )
[3]Java Application O <J:=com.myco.helloplugin (1.0.0.qualifier) O ' '
Ju Junit o= i i ifi
| -.l. : A E {J= com.myco.viewplugin (1.0.0.qualifier) ‘a Add Working Set... >
| Ju JUnit Plug-in Test = v ».ruTarget Platform - !
| @ Launch Group 4 =)= com.ibm.icu (4.0.1.v20090415) o - - >
) Add Required Plug-ins
| 4> 0SGi Framework T4 - com.jeraft.jsch (0.1.41.+200903070017) ) 1 3 ’
| 4 ¥ javax.servlet (2.5.0.v200806031605)
— v Y| (¢ Restore Defaults )
t 1 e ———— - > .
| @ Include optional dependencies when computing required plug-ins
|
t BT Add new workspace plug-ins to this launch configuration automatically
|
[_] Validate plug-ins automatically prior to launching _ Validate Plug-ins
|
[ 3
{ | Filter matched 11 of 11 items
|
i r’3 (" cClose ) € Run )

Run

How to Write Your Own Eclipse Plug-ins :
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1=
\2

(D

Bring up New View

In new Eclipse that launches,

.00 Show View
L ]
[ ) W I n d OW " type filter text
P (= Ceneral
° P (= Ant
> Show View
P (=C/C++
b (= CVS
h b (= Debug
> Ot e r.. . P (= DSF Examples
TN Window JETN 3 » (= Help
.| NewWindow B p (= Java
| P (= Java Browsing
Open Perspective > » (= Make
# Ant » (> Plug-in Development

7/13/09

Customize Perspective... E gonlsolet. » (= Remote Systems
. @, Declaration -

Save Perspectn{e As... o E ¥ (= Sample Category
Reset Perspective... ?) 9 -
Close Perspective fs Hierarchy £ Sample View
Close All Perspectives @ Javadoc P (= Tasks

2. Navigat =,
Navigation > 8- aw.ga or > (= Team

, o= Outline

f£ Package Explorer

[2/ Problems Use F2 to display the description for a selected view.

€ Progress

L5 Project Explorer
' Search

V| Tasks

&2 Templates

( Cancel \

¢

OK

How to Write Your Own Eclipse Plug-ins :
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D

e What functions

1000

Our New View

Runtime workbench

Java - Eclipse SDK

does it do? e l9-0-a- jEwa:

{2 Pac 82 . Te Hier, = O

* Click on stuff N

 Close the
runtime
workbench

@0 &

b= = A A £ &Jjava

How to Write Your Own Eclipse Plug-ins :
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P Look at code

Back in the Development workbench...

e SampleView includes Jface frameworks:

— ContentProvider: the objects that represent items

in the view See next
slide

— Label Provider: How to display the objects
— ViewPart: the subwindow

— Viewer: the widget for displaying objects
* TableViewer used here

How to Write Your Own Eclipse Plug-ins :

OSCON 09 39



7/13/09

o

Code for new view

ent - com m

pment - com. /Sample\

(wit’ |30 Qv | EHEG | @9 |9 8

| &1~ v xe v v

[ <=Plug-in Deve... {»

[£ Package Explo 83 . Plug-ins| = B || [J) sampleHandler.java

|J;_)} com.myco.viewplugin | [J] sampleView.java 2

=R-

VL:‘%com.myco.helloplugin
» =, JRE System Library [J25E-1.5]
» =, Plug-in Dependencies
v (#src
v £} com.myco.helloplugin
» [J] Activator.java
v EB com.myco.helloplugin.handlers
» [J] SampleHandler.java
» (= icons
¥ (= META-INF
1% MANIFEST.MF
@ build.properties
-ﬁ}plugin.xml
Vibdcom.myco.viewplugin
» = JRE System Library [J25E-1.5]
» =i, Plug-in Dependencies
v (@ Bsrc
» £ com.myco.viewplugin
v £} com.myco.viewplugin.views

» » [J] SampleView.java

P (= icons
¥ (= META-INF
1% MANIFEST.MF
@ build.properties
contexts.xml

private Action action2;
private Action doubleClickAction;

- /l

The content provider class is responsible for
providing objects to the view. It can wrap
existing objects in adapters or simply return
objects as-is. These objects may be sensitive
to the current input of the view, or ignore
it and always show the same content

(like Task List, for example).

* % X %X % % ®

S class ViewContentProvider implements IStructuredContentProvider {
a @ public void inputChanged(Viewer v, Object oldInput, Object newlr
}
a = public void dispose() {

}
a = public Object[] getElements(Object parent) {

return new String[] { "One", "Two", "Three" };
}

- class ViewlLabelProvider extends LabelProvider implements ITablelLabel
a @ public String getColumnText(Object obj, int index) {
return getText(obj);

a = public Image getColumnImage(Object obj, int index) {
return getImage(obj);

a = public Image getImage(Object obj) {

= =g
BRY o XY
com.myco.viewplugin.vi 4
» "= import declarations M
v® SampleView
FFip - String
o viewer : TableViewer
actionl : Action
action?2 : Action
o doubleClickAction - 4
> Q ViewLabelProvider
Q NameSorter
@ © SampleView()
| © . createPartControl(Compo
v @ hookContextMenu()
»Q new IMenulListene]
@ contributeToActionBi
@ fillLocalPullDown(IM¢
@ fillContextMenu(IMer|
@ filllocalToolBar(ITool
v @ makeActions() : void
}Q new Action() {...}
>Q new Action() {...}
}Q new Action() {...}
¥ @ hookDoubleClickActily)
» G new IDoubleClickl__

4

1 plugin.xml return PlatformUI.getiorkbench(). v = showMessage(String) ¥
<€
7 - e ) S
Q] Error Log % ¥ Tasks| [ Problems|
Workspace Log
[ type filter text )
Message 'Plug-in |
o com.myco.viewplugin.views.SampleView.ViewContentProvider - com.myco.viewplugin/src J

How to Write Your Own Eclipse Plug-ins :
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e

New Class

* In Package Explorer under the new project, 1000 New Java Class g
. . Java Class -
Select package “com.myco.viewplugin” Create a new Java class. Q; [
tg Pad‘age Explorer Sé - Source folder: com.myco.viewplugin/src (" Browse... ) “
>15Jcom.myco.helloplugin ‘ \ - |
¥ =2 com.myco.viewplugin Package: com.myco.viewplugl.obj ) Browse... )

» =, JRE System Library [J25E-1.5 ["] Enclosing type: Browse.
» =, Plug-in Dependencies

e —
P )
v L;m src Name: Instrument
=8 com.myco.viewplugin i 5 ) default private protected

» £} com.myco.viewplugin.views

[T abstract [ final static
(Th|s makes the new ClaSS lea rd Superclass: java.lang.Object (" Browse... )
automatically fill in some values) inertaces: (ada. ) |

H Which method stubs would you like to create?
* File, New, Class LECIL

ing(] args)

— . 1 1 1 Do you want to add = - e templates and default value here) H
Package: com.myco.viewplugin.obj

— Generate comments

— Name: Instrument

— Constructors from superclass

(’?r ( cancel ) (7Finish )
— Finish /

How to Write Your Own Eclipse Plug-ins :
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 Add name, numStrings

* Add getters/setters:
— Select ‘Instrument.java’ file

— Context menu:

* Source >
Generate getters and setters

v £ com.myco.viewplugin.obj

v B commycoy  NEW >

> DsameleVi o0, .
icons

¥ (= META-INF Open With »

*Select all

vanresty  Open Type Hierarchy F4

Edit code for Instrument

public class Instrument {
private String name;
private int numStrings;

Generate Getters and Setters

O®N0

Select getters and setters to create

™ » o name
™ » o numStrings

(" SelectAll )

(" DeselectAll )

( Select Getters )

(" Select Setters )

) Allow setters for final fields (remove ‘final' modifier from fields if necessary)
Insertion point:

| Last member

<

| Sort by:

|
| Fields in getter/setter pairs

<

Access modifier

® public () protected () default () private

[ build.propertie  Show In XEW >
. « 4 Bcontextsx mi c wc
4 plugin.xml opy B =
Insertion point
Paste ®Y
I t b % Delete ®
Plug-in o
ast member B Pt S
Source 8BS Gl Format
Refacto N&®T >
.Generate ' ' lethod ' Organize Imports 080
. e lmport... Sort Members...
com.mycov 23 Export... Clean Up...
COI I I l I le ntS . O K P References > Override/Implement Methods...
) Declarations 2

Cenerate Delegate Methods...

i [ final ") synchronized

‘ sz Generate method comments

i 4of 4 selected.

‘ The format of the getters/setters may be configured on the Code Templates preference pag

|

( '3 ) ¢ Cancel ) (

-/
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Edit code for Instrument

Add String arg to constructor; set name

public Instrument(String name) {

this.name=name;
}
5= QOutline 83 = O
. LR/ e wY
i Save ﬁle # com.myco.viewplugin.obj
v@ Instrument
° h I' f o name : String
The outline so tar 5 pomSirings s e

@ getName() - 5tring

@ setName(String) : voic
@ getNumStrings( : int
@ setNumStrings(int) : void

How to Write Your Own Eclipse Plug-ins :
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/I wlo comments:
package com.myco.viewplugin.obj;

public class Instrument {

private String name;

private int numStrings;

public Instrument(String name) {
this.name=name;

}

public String getName() {

return name;

}

public void setName(String name) {
this.name = name;

}

public int getNumStrings() {
return numStrings;

}

public void setNumStrings(int numStrings) {

this.numStrings = numStrings;

}
}

How to Write Your Own Eclipse Plug-ins :
OSCON 09

Instrument.java

so far

|J| Instrument.java &3 «J# com.myco.helloplugin |J] SampleHandler.java

B />
package com.myco.viewplugin.obj;

beth

public class Instrument {
private String name;
private int numStrings;

*

public Instrument(String name) {
this.name=name;

}
the name
B
public String getName() {
return name;
}
name the name to set
public void setName(String name) {
this.name = name;
}
* the numStrings
public int getNumStrings() {
return numStrings;
}
numStrings the numStrings to set
public void setNumStrings(int numStrings) {

this.numStrings = numStrings;

}

44



%w Use new objects in ContentProvider

Edit SampleView.java (it’s under com.myco.viewplugin.views package)
In ViewContentProvider modify getElements() add ‘Instrument mandolin;’

public Object[] getElements(0Object parent) {

Instrument mandolin;|
return new String[] { "One", "Two", "Three" };

Hover over error marker (red X) to see “Instrument cannot be resolved to a type”

A public Object[] getElements(0Object parent) {
*: Instrument cannot be resolved to a type;l
return new String[] { "One",

Two", "Three" };

}

The code needs a import statement to resolve it.
See next slide on how to get Eclipse to fix it for you!

How to Write Your Own Eclipse Plug-ins :
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=@9” C Use Quick Fix - to fix import

*  Problem: “Instrument cannot be resolved to a type”
— Solution: need to add an import statement for the new class in different package

» Single click on Light Bulb / Problem marker — or
Use context menu (right mouse): Quick Fix — or —
(Windows Ctrl-1) (Mac: Command-1) to see suggestions:

- public Object[] getElements(Object parent) { ® " Sa
@ Instrument] mandolin; | O acre
} 4 Import 'Instrument’ (com.myco.viewplugin.cbj) |.. .
} < Import 'Instrument’ (javax.sound.midi) mport org.eclipse.swt.SWT;
class Vi ' '
2 publ © Create class 'Instrument import com.myco.viewplugin.obj.Instrument;

u . ' '
O Create interface 'Instrument

import com.myco.viewplugin.obj.Instrument;

* Adds import to top of file:

V*LI 'le 4

* Scroll up to see it wpl Last Edit Location (~Q) w
then, to go back:

How to Write Your Own Eclipse Plug-ins :
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Complete getElements()

* Use completion/content assist, templates, etc to help with coding
* Change Preferences to automatically position semicolon (see next slide)

public Object[] getElements(Object parent) {
Instrument mandolin = new Instrument("mandolin");
Instrument fiddle = new Instrument("fiddle");
Instrument banjo = new Instrument("banjo");

return new Instrument[] { mandolin, fiddle, banjo };

How to Write Your Own Eclipse Plug-ins : 47
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=CCliPSE

* Eclipse
Preferences allow
a lot of
customization

Preferences

®No

| type filter text

b Ceneral
- Ant
pC/C++
» Help
b Install/Update
VJjava
p Appearance
p Build Path
p Code Style
p Compiler
p Debug
v Editor
b Content Assist
Folding
Hovers
Mark Occurrences
Save Actions
Syntax Coloring
Templates
Typing
b Installed JREs
JUnit
Properties Files Editor
b Plug-in Development
»Run/Debug
pTeam
Validation
»Web
» XML

eNO Preferences
' semicolon Typing v v
vC/C++ -
wEditor Automatically close
Typing M “Strings”
vJjava
vEditor M (Parentheses), [square] and <angle> brackets
™ {Braces}
M Javadoc and comment regions
ﬁ Add Javadoc tags
Automatically insert at correct position
] Braces
Tabulators
M Tab key adjusts the indentation of the current line
The tab display value (currently 4) and whether spaces are used to
When pasting
M Adjust indentation
M Update imports
In string literals
M Wrap automatically
["] Escape text when pasting into a string literal
( Restore Defaults ) [ Apply )
7\
'\?/] ( cancel ) (—ox—)

How to Write Your Own Eclipse Plug-ins :
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i BEF Modify the Table View

Still in com.myco.viewplugin

Launch again. Hmmm ... not a very interesting view

& Sample View 53 . [% Problems @ Javadoc||i, Declaration| = O
i iV
Ecom.myco.viewplugin.obj.lnstrument@sfl5c3
Ecom.myco‘viewplugin.obj.Instrument@BSbSZl
Ecom.myco.viewplugin.obj.lnstrument@ea?f%

Modify the LabelProvider to provide the Instrument name
class ViewlLabelProvider extends LabelProvider implements ITableLabelProvider {
public String getColumnText(Object obj, int index) {
return ((Instrument)obj).getName();

}
Relaunch; see nice names SisampleNiswis . 21 Problems
Instrument
[ fiddle

oo banjo
— )
o/ mandolin

Now let’s add columns to the table

How to Write Your Own Eclipse Plug-ins :
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Modify the Table View

Add columns to the table

e Add to top of createPartControl():

*  Use QuickFix (click,F1)
to fix imports:
org.eclipse.swt.widgets

the javax.swing

classes that QuickFix

will also suggest!

New code down to here

Note you don’t want

3

public void createPartControl(Composite parent) {
TablelLayout layoutu:'}éw TableLayout();
table.setlLayout(layout);
table.setlLinesVisible(true);
table.setHeaderVisible(true);

coll.setText("Instrument");
coll.setWidth(150);

X TableColumn col2=new TableColumn(table, SWT.NONE);

col2.setText("Strings");|
col2.setWidth(90);

//Table table = viewer.getTable();
table.setHeaderVisible(true);
table.setLinesVisible(true);

//viewer = new TableViewer(parent, SWT.MULTI | SWT.H_SCROLL | SWT.V_SCROLL);

viewer = new TableViewer(table);
viewer.setContentProvider(new ViewContentProvider());
viewer.setLabelProvider(new ViewlLabelProvider());
viewer.setSorter(new NameSorter());
viewer.setInput(getViewSite());

How to Write Your Own Eclipse Plug-ins :
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Have columns, but...

e There are now two columns

£ Sample View £3 . |2 Problems| @ Javadoc| |, Declaration i ivy=ao
Instrument Strings
p— p—
|/ fiddle |o% fiddle
Ebanjo Ebanjo
p=°°jmandolin ?mandolin
.J| SampleView.java £3 ‘% com.myco.instr.featu @ site.xml «J+ com.myco.helloplugin 4

L]
( I }
. F IX get O I u I I I n eXt() class ViewlLabelProvider extends LabelProvider implements ITablelLabelProvider {

o public String getColumnText(Object obj, int index) {
Instrument instr = (Instrument) obj;
switch (index) {

to return label

case 1:
int num= instr.getNumStrings();

return Integer.toString(num);
y column

break;
}

return instr.getName();

How to Write Your Own Eclipse Plug-ins :
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Make columns nicer

Also change getColumnimage to only
return image for first column

bublic Image getColumnImage(Object obj, int index) {
if (index == @) return getImage(obj);
else return null;

}

Launch again; we now have:

& Sample View £3 \%( Problems| (

Instrument Strings
zbanjo 0
") fiddle 0
Eiﬁnandohn 0

How to Write Your Own Eclipse Plug-ins :
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£C!i 8 More if time permits

Add number of strings to Instrument objects

Add selection listener to col 1: open in debugger (Click on col heading to invoke/
get exception. What to catch? Surround with try/catch. ClassCatchException!
Show code templates that automatically appear for the required interfaces.)

Close runtime workbench; Edit manifest, change view name and category name;
relaunch

Optional Topic: hook up to model to receive changes

How to Write Your Own Eclipse Plug-ins :
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- Debugging

> =

® Set brea kpoint: \J] Instrument.java |J| SampleView.java &3 3

Instrument banjo = new Instrument("b«
return new Instrument[] { mandolin, |

}
[ ] }
DOUbIe—Cth class Vl?'/-quelPrOVIder extends Lat?elPron'der.
PaN public String getColumnText(Object obj, i
—>© | Instrument instr = (Instrument) obj;
at left edge— switch Cindex> {

case 9:
return instr.getName();

* Launch Eclipse debugger '#+27"Run

Debug
 Run and step thru code

How to Write Your Own Eclipse Plug-ins :
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= [ml Me Breakpoints\] = I({’@ &R RS 8

% &7 & M3 @ %D T4 |6><9 < || Name
¥, Daemon Thread ftatline9linSa 2~ . th
= SampleView$ViewLabelProvider.getColumnText(Object, int} lin
~omnaex

= TableColumnViewerLabelProvider.update(ViewerCell) line: 70

= ColumnViewer$3(ViewerColumn).refresh(ViewerCell) line: 145 .

= TableViewer(AbstractTableViewer).doUpdateltem(Widget, Obje(» v
‘<« F B iy

com.myco.viewplugin.obj.Instrument@3fdbl5

Value

SampleViewS$ViewLabelProvider (id=85)
Instrument (id=121)

0

7 3 ~ N O- . i
i} com.myco.viewplugin I [J] Instrument.java | [J] sampleview.java £3 \-..\_»z = B |/ 5= Outline 83 L =0

Instrument banjo = new Instrument("banjo"); A

return new Instrument[] { mandolin, fiddle, banjo }; mn
}

: 0

- class ViewLabelProvider extends LabelProvider implements ITablelLabelProvid:

a = public String getColumnText(Object obj, int index) {
» Instrument instr = (Instrument) obj;
switch (index) { -
case 9: v
<€ ) S

R o Y

## com.myco.viewplugin.views A
» ‘= import declarations m
v® SampleView

FFIp String
o viewer : TableViewer
o actionl @ Action N

i ctinr .v
“_n_munnu_uﬁ v~

=] console 23\\{?_.] Tasks\]

% % | B £B[E]&E] ¢ B~ r3- = B)

New_configuration [Eclipse Application] /System/Library/Frameworks /JavaVM.framework /Versions/1.5.0/Home/bin/java (Jul 8, 2009 1:41:37 PM)

7/13/03 OSCON 09

¢l |[alp=*s)
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& A Help Plug-in

* First, bring up Eclipse help to see what it does
— Help > Help Contents

* For more info: see help, Platform Plug-in developer guide
>programmer’s guide > user assistance support > Help

e Let’s make a help plug-in project, and use the
wizard as an example

How to Write Your Own Eclipse Plug-ins :
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Help Plugin Project

* New plugin project

Lﬂ M O Plug-in Development - com.myco.help/html/maintopic.html - Eclipse SDK - /Users/beth/ews/tut

v B Q Q- | LW G| ™ 4
* Name: com.myco.help, e %0 v D

Next >, Next > 4 Package Exp 13

fr{ %5 Debug [dyCVS Reposit...

< Plug-ins| = 8 maintopic.html 82 1 =0

|5 maintopic.html
- v }:'DOCTYP[ HTML PUBLIC "-//W3C//DTD HTML 4.0 Transit

<html>
<head>
<meta http-egquiv-"Content-Type" content-"text/h

 Plug-in with sample help content; | ,Zonmee

¥ |= com.myco. help
Finish

» B, JRE System Library
* Project is created; manifest opens

» B\ Plug-in Dependencies
» Bsrc
v = html
.| maintopic.html
:| subtopic.html
=] toc.html
¥ & META-INF
4} MANIFEST.MF
ors Duild. properties

* Peruse project contents:
html, xml, etc.

& plugin.xml
& testToc.xml
& toc.xm
L] com.myco.tableViewPlugin2
» .= com.myco.viewplugin
» = david

'
|
|
i
|
'
i
|
|
i
|
|
'
"

<title>Main Topic</title>
</head>

<body>

<h1>Main Topic</hl>

Please (You can type here too) here. Here too.
</body>

</html>

&) Error Log | v Tasks | [2. Problems Console 3

No consoles to display at this time.

maintopic.html - com.myco.help/htmi

7/13/09 OSCON 09
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& Install XM

e We need html/xml editor: Install them!
— Help >Install new software
— Work with: Galileo site
— Under Web, XML, and Java EE Dev...
— Choose “Eclipse XML Editors and Tools”
and
— “Web Page Editor”
— Next >, Next >
Accept, Finish
Restart type fier text
- Name . ) ) Version
O <= Eclipse Web Developer Tools 3.1.0.v2009052.
O <+ Eclipse XSL Developer Tools 1.0.0.v2009052
O <) JavaScript Developer Tools 1.1.1.v2009060
O )= )ST Server Adapters 3.1.0.v2009031
O -(l.:JST Server Adapters 3.1.0.v2009031
O LJ*)ST Server UI
0 J=)ST Web UI 3.1.0.v2008012
O <= PHP Development Tools (PDT) SDK 2.1.0.v2009061
O 4= Rich Ajax Platform SDK (RAP) 1.2.0.20090616
™ L+ Web Page Editor (Optional)
O 4= WST Server Adapters 3.1.0.v2009060
Details
7/13/09 How to Write Your Own Ecli
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3.1.0.v20080930-7A2FB_9xFaFovXGKcCTNA

2.2.0.v20090310-43390B55W5K6F

L/HTML Editors

L1000

Install

Available Software

w
D

Check the items that you wish to install.

Work with: | Galileo - http://download.eclipse.org/releases/galileo 3 ( Add... )
Find more software by working with the 'Available Software Sites' preferences.
type fi te
Name Version
(7] » 000 Modeling A

| » 000 Programming Languages
| p (00 SOA Development
| » 000 Test and Performance
11X Web, XML, and Java EE Development
«J+Apache MyFaces Trinidad Tag Supg 2.2.0.v20090517-20-7w311A1636
= Axis2 Tools 1.1.0.v200905242110-78-FBpDZRDE6FdPd

‘

Details

Tools to help create web applications, including JavaScript, XML, XSL, XSD, HTML, XHTML, CSS, JSP, EJBs,

M Show only the latest versions of available software ] Hide items that are already installed

M Group items by category What is already installed?

M Contact all update sites during install to find required software

G
()

Cancel )

Fimes s T uLLLIYOL DTG

1c-20-7w311A1422¢
1b-777HFDNCcNBBz-BcKWE

80155-7E77FBbDlwYa_95f5
1-0930-51-84QACBIHRILOr
-1439

o &)

20451-51DFAKF7797GCNc
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W Editing HTML

(D

v (= html bod
1 <bodv>
_ maintopi G » opic</his

5] subtopic. u can type here too) her|
[2) toc.html Open B
META-INF
) > 5 bl prope B HTML Editor
® O O Plug-in Development - com.myco.help/html/maintopic.html - Eclipse SDK - /Users/beth/ews /tutorial-workspace (@) Lipluginxml | Show In >[I Text Editor
. o . . = E testTocxml @ Web Browser
| B~ IO Q@  BEHFC B [y %5 Debug [azCVS Reposit... <= Plug-in Deve... » ] toc.xml - Copy i ®C v B Web Page Editor
; . B . Jcom.myco.table 5= Copy Qualified Na
| \,—- ' - ) ) >‘ijjconf.myco.vlew % Paste 5 System Editor
[% Package Exp 82 2 Plug-ins| = O || [J] SampleHandler.java [£] maintopic.html 82 10 = 0|z oui 3, = 0O ’g;a;’;: % Delete Default Editor
=1 = o T T e - = bb—forg.ecllpse.p!p. Build Path 4 Qther...
7 - - <html> — - Refactar 32T b
» =7 com.myco.helloplugin A ‘} d |4 DOCTYPE:HTML
J <head>
v%;r}:{‘?;i:t.::iibrary U2SE-1.5] <meta http-equiv="Content-Type"” content="text/html; cha v %:‘Z":ead SeIeC i e ri Ouse
A gest=2.9 <title>Main Topic</titlex t g t
» =) Plug-in Dependencies </head> v [J body ’ ’
» (@src <>hl .
v o Open With...
[Z] maintopic.html <h1-Main Topic</hl>
2 subtopic.html Please enter your text here. . : . .
[Z] toc.html </body> ﬁ [# Package Exp $2 . Plug-ins| © O || [£] *maintopic.html |, *maintopic.html §3 7»11 =08
b (= META-INF </html> %Y _ — &~
= . . al & e =) = o
|o16 build.properties - = - » =2 com.myco.helloplugin
4JF plugin.xml Q‘Error Log | = Jasks [: Problems Console §3 v]zjdcommyco.help
QJ testToc.xml _ || No consoles to difiplay at this time. » = JRE System Library [)25E-1.5)
2] toc.xml v » =i, Plug-in Dependencies : s
[ — ) > @Bsrc Main Topic
V¥ (= html

|=| maintopic.html
[Z] subtopic.html
[Z] toc.html

Please here. Here too.

* HTML Editor: / b = META-INF
st build.properties /

4 plugin.xml

syntax highlighting, outline, 8 e
completion, etc.

>t;—%org.eclipse.ptp.pld(.commcn [dev.ec

*\Web page editor:
«2-pane with

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.9 Transitional//EN"

<html>

<head>
<meta http-equiv="Content-Type"” content="text/html; chars
<titles>Main Topic</title>

</head>

<body>
<h1l=Main Topic</hl>

Please (You can type here too) here. Here too.
</body>

</html>

v

s
n

WyS iWyg Design| Preview
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e

° Open With > XML Editor — pesign and Source tabs

You don’t really need the
XML editor for editing

‘ ,-’:Er’-ckage Explorer 53 <= Plug-ins
3

VIDJcom.myco.helloplugin
» =5, JRE System Library [J2SE-1.5]
» =, Plug-in Dependencies
v (@#Bsrc
v £ com.myco.helloplugin
» [J] Activator.java
v £ com.myco.helloplugin.handlers
» [J] SampleHandler.java
P (= icons
¥ (= META-INF
4+ MANIFEST.MF
@build.properties
&) build.xm!
javaCompiler...args
mplugin‘xml
VIDJcom.myco.help

7/13/09

0

dor

Editing XML

31 @) commanaia
# com.mycol] New > - t c‘|a55
€| extension
*MARE Sy_ste Open F3 (3 point
» B, Plug-in o ) i )
» (B src _ 4 Plug-in Manifest Editor
+ (= htm Show In W > [ Text Editor
S P
Dmanl S Copy - #C

[ build.orc 52 Copy Qualified Name | System Editor

A0 plugin.xi = Paste EAY Default Editor

2] testToc. % Delete

[ tocxml Other...
8 «J+ com.myco.helloplugin 5‘&. com.myco.viewplugin X plugin.xml g3
¥ |, version="1.0" encoding="UTF-8"

T ??eclipse
m || v [e] plugin
¥ [e] extension

¥ [e] extension
point
v [e] handler

version="3.4"

org.eclipse.ui.handlers

Eclipse manifests, however.
There are special editors for

these.

= B /5= outline 53
A ?22xml
?2eclipse
v [e] plugin

¥ [e] extension point=org.eclipse.ui.comn
[e] category id=com.myco.helloplugii
[e] command id=com.myco.hellopluc
¥ [e] extension point=org.eclipse.ui.hand|

[e] handler commandld=com.myco.h

> [e] extension point=org.eclipse.ui.bindi
b [e] extension point=org.eclipse.ui.menu

@ point org.eclipse.ui.commands

v [e] category
@ name Sample Category
@ id com.myco.helloplugin.commands.category

v [e] command
@ name Sample Command
(@ categoryld com.myco.helloplugin.commands.category
@ id com.myco.helloplugin.commands.sampleCommand

com.myco.helloplugin.commands.sampleCommand v

ommandld
( Design| Source

N
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Launch the runtime workbench -- as before

Run the Help Plug-in

Make sure the new plug-in is included in the plug-ins included in the

launch configuration

. . ®00 Help - Eclipse SDK 1
(It probably IS) | + | http://127.0.0.1:58389/help/ind: & | (Qr , b3
: . [ =  Google Reader WA4DAC findu APRS geos »
In runtime WorkbenCh' Eclipse Downloads 1 Help - Eclipse SDK + |
—_ Help > Help Conte nts Search: | | m Search scope: All tO:.i
Content ;'| ' = 00 =N | Bl = By
- See yOUF new Co nte ntl + % Workbench User Guide Test TOC > f
+ % Java development user guide :
+ %2 Platform Plug-in Developer ( ] ]
+ % JDT Plug-in Developer Guide Maln Toplc
+ %> Plug-in Development Enviro
%> C/C++ Development User Gu| Please enter your text here.
. " ” =l ] Test TOC
Other components of Eclipse “Help = O Maim Topic
5 Sub Topi
— Cheatsheets — walk user thru steps un Toeie ,
{ |
“Welcome” page content .
— ..etc ] >
. Display a menu Y
How to Write Your Own Eclipse Plug-ins : 61
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D Packaging

* You want others to be able to install your
plug-in(s)

* Steps:
1. Create a feature to list the plug-ins

2. Create an update site project with your
feature(s)

3. Build it, test the install, and distribute
e Zip archive, or
e On web site

How to Write Your Own Eclipse Plug-ins :
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Create a feature project

* An Eclipse feature encapsulates one or more
plug-ins. It’s the unit which is installed by users.

. . N0 New Project
* File > new Project, ot —
Plug-in Development >

er text ) |
L]
Feature Project Al
J £ Java Project from Existing Ant Buildfile M |
¥ Plug-in Project ‘
» (= General ‘
Next >
» (= CVS
P (= Java
. ¥ (= Plug-in Development

° PrOJect name: e g G Feature Patch
L] L] L]

M reawreprojec _______________________________|}i}

4= Fragment Project

com.myco.thing.feature U
Next >

@ € Next> ) ( cancel )

How to Write Your Own Eclipse Plug-ins : 63
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* Add plug-ins

Check all the plug-ins you made
* Finish

7/13/09

Add plugins to feature

®N0

New Feature

Referenced Plug-ins and Fragments

Select the plug-ins and fragments from your workspace to package into
the new feature.

() Initialize from a launch configuration: = New iguratior

@ Initialize from the plug-ins list:

@—.

O z¢:=com.ibm.icu (4.0.1.v20090415) Al selectAl )
[7) #=com.ibm.icu.source (4.0.1.v20090415)

mR i i

1 &p=com.jcraft.jsch (0.1.41.v200903070017) Deselect All )

O ?‘Ir com.jcraft.jsch.source (0.1.41.v200903070017)
I w-com.myco.helloplugin (1.0.0.qualifier)

™M g com.myco.help (1.0.0.qualifier)

M <J= com.myco.viewplugin (1.0.0.qualifier)

O ?‘Ixjavax.servlet (2.5.0.v200806031605)
M Ny

i cc o o D NN AAADACATCNT

D s >

3 of 545 selected.

(?jl < Back Next (

Cancel

0 Finish )

OSCON 09
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You are editing the
feature manifest,
feature.xml

On the Plug-ins tab:

Versions...

— Copy versions from plug-ins

— Finish

Save the feature.xml

7/13/09

Feature versions

. com.myco.thing.feature 23 5,;,‘; com.myco.helloplugin [J] *sampleHandler.java 5‘,1;:

% Plug-ins and Fragments

Plug-ins and Fragments laz Plug-in [

Select plug-ins and fragments that should be packaged in this feature. Specify it

4v-com.myco.helloplugin (0.0.0) Add... Name

<J=com.myco.help (0.0.0)

«J== com.myco.viewplugin (0.0.0) Versions...
Downloa:
" i Installat
Overview | Informati Plug-ins| In§luded Features Dependencies Instgflation | Build | feature.xml
\—/ /

16000 Feature Versions

Version Synchronization p—
Choose a method to synchronize feature and plug-in !
versions.

O Synchronize versions on build (recommended)
(®) Copy versions from plug-in and fragment manifests

() Force feature version into plug-in and fragment manifests

(’;7:1 ( cancel ) (E Finish 3 )

How to Write Your Own Eclipse Plug-ins :
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& Update Site

Create update site project
New Project, Plug-in Dev, Update Site Project
Name it e.g.: “update”

— You’re editing the site.xml file

— Add your new feature to the “Site Map” page.

| *site.xml g3 ‘% *com.myco.thing.feat «J+ com.myco.helloph

@ Update Site Map

Managing the Site

1. Add the features to be published on the site.

2. For easier browsing of the site, categorize the features by
dragging.

3. Build the features.

3. com.myco.thing.feature (1.0.0.qualifier) Nev ory

< Add Feature... >
‘ Build
| Build All

rchives site.xml

How to Write Your Own Eclipse Plug-ins :
OSCON 09

66



— Hints and tips:

Add index.html|

— Add an index.html file if you plan to host the update site on a server.

— Then if users go to your update site URL in a browser, they won’t see an error.

— These directions tell them to use the URL within Eclipse, not a browser.

/ --".. .\l
[# Package Explorer 83 . = O

=

%:DV

I [;_'—‘,]'com.myco.helloplugin
> b" com.myco.help

» =% com.myco.mything.feature
» =% com.myco.thing.feature

| 2 'bJ com.myco.viewplugin
¥ =% update

index.html

) site.xml

7/13/09

) *sitexml | G com.myco.thing.featu | 5 com.myco.mything.

<body>

<p>This 1s the Eclipse update site for com.myco.thing.

<p>

Please install this into Eclipse via Help > Install New Software...
and add this URL as a new update site.

<p>
This file assures that if a user goes to your update site URL
in a browser, khey'll see something, and not an error.

</p>
</body>
</html>

How to Write Your Own Eclipse Plug-ins :
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* Bu”d the update Site v “site.xml 23 ‘.\; *com.myco.thing.feat . ﬂ;com.myco.helloplt
— CI'Ck ”Bu||d A”” & Update Site Map

Build the Update Site

. . Managing the Site
- Or: Slte.xml > rlghtMouse > 1. Add the features to be published on the site.
2. For easier browsing of the site, categorize the features by
. . dragging.
PDE TOOlS > BU||d Slte 3. Build the features.
Com )
) nchronize...
Compare With 2 Ll il
Replace With [ 2
PDE Tools > Build Site R .
P — - \ Build All >

rchives site.xml

How to Write Your Own Eclipse Plug-ins :
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- Update site: what got built

* This project contains the update site :
— site.xml

. % Package Explorer £3 =1\ N
- |ndeX.htm| v =% update
Vv (= features
e &% com.myco.thing.feature_1.0.0.200907071910.jar
— features dir v & plugins
L= plug
& com.myco.helloplugin_1.0.0.200907071910.jar

_ p|ugInS d|r = com.myco.help_1.0.0.200907071910.jar

¢ com.myco.viewplugin_1.0.0.200907071910.jar
So artifacts.jar
S5 content.jar
|=] index.html

¢ NOtESI i site.xml

— In versions, “qualifier” was replaced with timestamp

— Move these to a web/file server and you have an
update site!

How to Write Your Own Eclipse Plug-ins : 69
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<9 Update site: Test install

— Extract a clean Eclipse SDK

e Tar or unzip ... launch ... use new workspace name

$ mkdir test-install
$ cd test-install
$ tar -xzf ~/downloads/eclipse-SDK-3.5-macosygonras +2r o2 o
$ cd ecl ipse | Available Software
! Check the items that you wish to install.

$ ./eclipse

Work with: | test update site - file:/Users/beth/ews/tutorial-workspace /update/ -
i H e I p > I n Sta I I N eW Find more software by working with the "Available Software Sw(es'/re erences.

Software... e
A 4 Uncategorize d

e Add...Local anyname will do

WOLOUC Add Site

* Point at your update site project location

cation: | http:// Archive...

* Check your feature, finish install, restart Eclipse ..\

* Voila! New button in toolbar; new view too.

How to Write Your Own Eclipse Plug-ins :
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(Optional) Tweak feature/install

 Add a named Category

— Update Site project: edit site.xml; on “Site Map”

tab, click “New Category”, give it a name, drag
your feature under it

— Rebuild site  site.xml| > PDE Tools > Build Site
* Create new empty eclipse SDK (unzip again)
* Re-install: may not see the changes you made.

Remove update site project & re-add, re-build.

— Caching makes this awkward!!

How to Write Your Own Eclipse Plug-ins :
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(Optional) Handmade New Extension

Contributing to an Editor’s toolbar — action to count words in
editor selection

In a new plugin project, or an existing one: Edit plugin.xml: Manifest editor, extensions tab
Add: org.eclipse.ui.editorActions

Target id: org.eclipse.ui.DefaultTextEditor (use browse .... To find it )

new > action

label: “MYCO: word count ”

— lcon: select the icons/sample.gif already in project

—  Tooltip: “MYCO: show word count of selected text”

— enablesFor: “+” (one or more selected items; this is editor so an item is a character in the editor)
— Toolbarpath: “additions”
— Id: (optional) change to com.example.helloworld.wordcount (just for sanity)

— Class:

click underscored “class*:” to create with wizard
Name: WordCounter
Enter code.... (see next slide or provided sample files for run() and selectionchanged() methods
Manifest: Add dependency on org.eclipse.ui.editors  to resolve “TextEditor”
— Add dependency on org.eclipse.jface.text to resolve “ITextSelection”
Show Quick Fix, Organize Imports... to fix the imports

— Test plugin! Launch runtime workbench.

Select text in editor, run new Action. Note any selection works. Remainder is Optional:

Change to only enable on editor text selection — close runtime workbench.

Extensions, rightmouse on “MYCO: word count (action)” New > selection and browse for “ITextSelection”
Inspect the plugin.xml that was generated. See how the XML changed.

Relaunch; note action button is greyed out if text isn’t selected in the editor

How to Write Your Own Eclipse Plug-ins :

OSCON 09 72



P (part of) WordCounter.java
Past this inside the class {}

private TextEditor textEditor;
static final String WORD_DELIMITERS =" .,/?<>;:[[{}\\| ~!1@#5%"&*()-_+=\n\r";

public void setActiveEditor(lAction action, IEditorPart targetEditor) {

textEditor = (TextEditor) targetEditor;

}

public void run(lAction action) {
IDocument document = textEditor.getDocumentProvider().getDocument(textEditor.getEditorinput());
ITextSelection ts = (ITextSelection) textEditor.getSelectionProvider().getSelection();
int tokenCount;

try {
String text = document.get(ts.getOffset(), ts.getLength());
tokenCount = new StringTokenizer(text, WORD_DELIMITERS).countTokens();

} catch (BadLocationException e) {

tokenCount = 0;

}

MessageDialog.openinformation(null, "JDG2E: Word Count", "Number of words: " + tokenCount);

}

public void selectionChanged(lAction action, ISelection selection) {

if (selection != null && selection instanceof ITextSelection) {

ITextSelection sel = (ITextSelection) selection;

if (sel.getLength() == 0) {

action.setEnabled(false);

}else {

action.setEnabled(true);

}

}else {

action.setEnabled(false);

}

}

How to Write Your Own Eclipse Plug-ins :
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- SA:Source Code Analysis

.. And some source code repository fun @ dev.eclipse.org
... And some plug-in dependency debugging

We will do some source code analysis on C/C++ code
First get CDT (Eclipse C/C++ Development Tools) : Help > Install new software, Galileo site

— Galileo Site > Programming Languages, Eclipse C/C++ Development Tools — gets the basics
Or: Add Site: http://download.eclipse.org/tools/cdt/releases/galileo - Lots more incl. alt. parsers,
UPC

* Note: you must have gcc/gdb/make etc. to actually build/run C code — but not required for this
tutorial

— Install and Restart eclipse
Check out a plugin project from dev.eclipse.org repository:
— Window > Open Perspective > Other ... CVS Repository Exploring
— In CVS Repositories view, rightMouse, New > Repository Location...
* Host: dev.eclipse.org
* Repository path: /cvsroot/tools
* User: anonymous; hit Finish
— Under the repo location, under HEAD, open org.eclipse.ptp, open tools folder, open samples folder
— Check out org.eclipse.ptp.pldt.sampleCDTstaticAnalysis (rightMouse, Check Out)
— Go back to PDE Perspective

How to Write Your Own Eclipse Plug-ins :
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. Look at project org.eclipse.ptp.pldt.sampleCDTstaticAnalysis you just checked out from eclipse.org

. Note red X's — open Problems View

SA2: Source Code Analysis

. It seems we are missing some required
plug-ins

*  DETOUR: rest of this page is optional

. Try to see if we can do without them:
—  Edit META-INF/MANIFEST.MF
— Dependencies tab, Remove:

ﬁ% ora.ecliﬂseiw.ﬂdt.samEleCDTsuchnﬁisis g

% Dependencies

Required Plug-ins laz

Specify the list of plug-ins required for the operation of this plug-in.

?;;:zorg.eclipse.ui Add...
?;;:: org.eclipse.core.runtime

%I:: org.eclipse.cdt.core
:= org.eclipse.core.resources Up
«/v-org.eclipse.ptp.pldt.common
;w--org.ecllpse.ptp‘pld!.mpl.analysis Down
v org.eclipse.ptp.pldt.mpi.analysis.cdt

Properties...

Total: 7

» Automated Management of Dependencies laz

©] Error Log

111 errors, 21 warnings, 0 others (Filter matched 121 of 132 items)

‘Description & |Resource

v @ Errors (100 of 111 items)
Q. Bundle 'org.eclipse.ptp.pldt.common' cannot t MANIFEST.MF
Q. Bundle 'org.eclipse.ptp.pldt.mpi.analysis.cdt' ¢ MANIFEST.MF
Q. Bundle 'org.eclipse.ptp.pldt.mpi.analysis' cann MANIFEST.MF

Q GraphCreator cannot be resolved to a type
Q. GraphCreator cannot be resolved to a type
, GraphCreator cannot be resolved to a

Overview | Dependencies RuntimelExtensions Extension Points‘BuiIdIMANII

7/13/09

«Save manifest.
*Errors are still there. Darn.

*Get MANIFEST.MF back as we found it:

srightMouse, replace with,

Latest from HEAD

Path

forg.eclipse.ptp.pldt.samgp
forg.eclipse.ptp.pldt.samg
forg.eclipse.ptp.pldt.samg

Q. ControlFlowGraph cannot be resolved to a typ BuildCFCraphHandle forg.eclipse.ptp.pldt.samg
BuildCFGraphHandle forg.eclipse.ptp.pldt.samg
BuildCFGraphHandle forg.eclipse.ptp.pldt.samg
e BuildCFGraphHandle /forg.eclipse.ptp.pldt.sam

Team >
Compare With > .
Replace With > Latest from HEAD '
PDE Tools > Another Branch or Version... :
. _ History... |
= Properties X previous from Local History
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SA3: Source Code Analysis

Let’s check out the projects we need to correct the dependency errors.
Back to CVS Repository Exploring Perspective

() CVS Repositories £3 o W=

Check out org.eclipse.ptp.pldt.common v B org.eclese oo

and org.eclipse.ptp.pldt.mpi.analysis.cdt b (= core
» (=-debug
» (= doc
Resolve errors: Force a rebuild: b (= lang
. p (= photran
—  Project > Clean... > G rdt
Clean projects selected below » = releng
. . . P (=rms
Check the sampleCDTstaticAnalysis project v & tools
There is still one error: > & cell
» (= old

b (= org.eclipse.ptp.pldt.common

@] Error Lo V«'E Tasks [[2 Problems 23 Console
= - AL E » (= org.eclipse.ptp.pldt.help

1 error, 105 warnings, 0 others (Filter matched 101 of 106 items) » (= org.eclipse.ptp.pldt.lapi
‘Description 4 |Resource » (= org.eclipse.ptp.pldt.mpi.analysis
¥ @ Errors (1 item) b (= org.eclipse.ptp.pldt.mpi.analysis.cdt ‘ New
Q‘ Bundle 'org.eclipse.ptp.pldt.mpi.analysis' cannot be resolved MANIFEST.MF » (= org.eclipse.ptp.pldt.mpi.core
» (= org.eclipse.ptp.pldt.openmp.analysis Check Out
. A ’ . b (= org.eclipse.ptp.pldt.openmp.core Check Out As
But Note that there are no compile errors; let’s assume this b G org.eclipse.ptp.pldt.openmp.ui.pv
dependency isn’t necessary > @-org.eclipse.ptp.pldt.upc iz Tag as Version...
. . i . p (= org.eclipse.ptp.pldt.wizards . P
Edit MANIFEST.MF; Dependencies tab; Remove mpi.analysis; » (5 ora.eclipse.ptp.remotetools.core Tag with Existing...

save manifest

Errors gone! If you still get dependency errors, and you are sure you shouldn’t, try (1)

rebuilding project, or (2) removing and re-adding the dependencies
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= SA4: Source Code Analysis

— Launch runtime Eclipse workbench with new plugins

— Open C/C++ Perspective

* Window >Open Perspective > Other... and select C/C++ Perspective S ]
® T O Show View

* [Fit’s not there: Let’s inspect

— Close runtime workbench " type filter text
— Open Launch config, Plug-ins Tab, Target Platform ¥ (= General Al
» Make sure all the CDT plugins are checked “mBOOKr.mrks
» Classic Search
» Easier: Check all at the top of Target Platform &l console :

» Relaunch: TA-DA! Open C/C++ Perspective ___ MErorlog

) Internal Web Browser
—  We expect to see more toolbar buttons. Where are they? [2 Markers

* Open the Error Log view: Window > Show View > Other ‘E':]:.Nnvigator
DE Outline

* Nonews. . Palette
* Close Runtime workbench. Open Launch Config. [2{ Problems v

* On plugins tab, click “Validate Plug-ins” (lower right) Use F2 to display the description for

a selected view.

6eno Validation | | AEEETE———
[ Validate Plug-ins
The following problems were detected: e ——
» <= org.eclipse.jdt.apt.pluggable.core { hY ( 3
» -5~ org cdipse . comaier.apt _ CGancel ) [ OK ,
b =3 org.eclipse.jdt.compiler.tool
v )= org.eclipse.ptp.pldt.sampleCDTstaticAnalysis
<J=Missing Constraint: Require-Bundle: org.eclipse.ptp.pldt.common; bundle-version="0.0.0"
@ ok )

Missing plugin!! Is pldt.common checked in the plug-ins list under Workspace? If no, check it.
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& 5A5: Source Code Analysis

Re-launch runtime Eclipse workbench with all the changes
You should now see the icons for the analysis

Now make a CDT Project
New C Project — Hello World ANSI C Project | Get source samples from cdt analysis

Ao — plugin, under ‘samples’ dir
I *Copy and paste from one Eclipse

Project name: | helloC

workbench to another!

M Use default location

«See

e | http://www.eclipsecon.org/2008/?
= page=sub/&id=373 - presentation
P “Static Analysis in PTP with CDT”
| @ hext> ) (Canel ) (rmsh w;
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& 5a6: Source Code Analysis

‘OO C/C++ - Hello/src/wéika{.;»t_edge.c = Eclip-s-é SDK -

.I: M = OI'Lc_"V v ¢v(@E~ ‘6&' B ‘1\:5'0"’-' ‘O' LG A A ‘—‘

Show Show
Control Flow

Walk

AsT gf;/oh Graph
*Walkast.c
.c| walkast.c 23

/7 p16 *Select Walkast.c file in
deFine WYVAR 42 Project Explorer
int mainCvoid) «Select “Walk AST” icon in

at; editor toolbar

g wndidianiadieie -See text output in (dev. Workbench) console
, et b *Note: tree walk includes header files
it fooCin bant (it's long!)
, et = *See src to this plug-in for examples of

C/C++ manipulation
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o Summary

Eclipse development has a steep learning curve

— “swimming pool of Legos®”

— It’s worth the investment!

— Great set of tools, great community
This tutorial is really just a “taste” of Eclipse development
Take advantage of resources

— Books, sites, help..

— Newsgroups and mailing lists
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